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1 Information on the Current Version and 

History 

1.1 Version 2.80.0 (June 2021) 

New Functionality 

● R&S DVMS4 DVB-T2 (R&S DVMS-B55 model 03): 

The measurement application for the MER measurement can now be switched 

between “Transmitter” and “Antenna/Repeater”.  

In case of multipath reception it is recommended to use the “Antenna/Repeater” 

setting. For multipath free reception the setting “Transmitter” should be used. 

Modified Functionality 

● Interpreter (R&S DVMS K20): 

Table Interpreter allows now values different from 0xF for element 

"stream_content_ext" in the "Component Descriptor" of SDT. 

● T2-MI Extension (R&S DVMS-K3):  

The feature "hiding of events" is applicable for the PLP layer, but not for the T2MI 

layer. A hint on this has been added. 

● Service streaming to an external device: 

The label "Source" is now always consistent to the stream played out. A double 

click on a different PID now allows a quick change of the stream played out. 

Please note, that the external decoder must be capable to adapt dynamically to 

the new PID. 

● Operating system: 

The usage of virtual memory (paging file) is enabled. This measure is to prevent 

from low memory warnings, occasionally indicated by the operating system. The 

paging file size is system managed and activated for the hard disk drive D: only.  

 

Fixed Issues 

● Corrected occasionally loss of T2MI PLP configurations at monitoring start. 

● Removed the system report entry “Log Overflow”.  

● The advanced measurement “PTS Repetition” now shows valid results even if the 

PTS intervals are greater than 1 second. 

● The PCR accuracy measurement has sometimes (especially in case of variable 

bit rates, or shortly after synchronization was achieved) reported an additional 

event. The measurement is now modified to achieve robustness after 

synchronization or for variable bitrate transport streams. 

● A potential issue in the data update for RF measurements has been fixed: if an 

update freeze is detected, the measurement core is restarted after 30 seconds. 



R&S DVMS Information on the Current Version and History 
 

 

 

 
Release Notes 2113.7683.00 -  5 

 

● R&S DVMS with IP module (R&S DVMS-B40): 

In DVMS applications using both network adapters of B40, some IP In-Flows 

show IP/TS Sync Loss after start of application TS Analyzer. This happens under 

special instrument configurations (IP In Flow config) and when the instrument or 

just the application TS-Analyzer is started. This has been corrected.  

● Interpreter (R&S DVMS K20): 

Correction of CRC checksum calculation for “Network Synchronization” within 

Packet Interpreter for ISDB-T transport streams. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

1.2 Version 2.72.0 (October 2017) 

New Functionality 

● None 

Modified Functionality 

● None. 

Fixed Issues 

● R&S DVMS with Windows 7 and installed IP module (R&S DVMS-B40) : 

DHCP did not work for IP adapters of R&S DVMS-B40. IGMP query messages 

from multicast routers or switches were not acknowledged. This has been 

corrected. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

1.3 Version 2.70.1 (September 2017) 

New Functionality 

● None. 

Modified Functionality 

● None. 

Fixed Issues 

● R&S DVMS1 with Windows 7 and installed IP module (R&S DVMS-B40): 

The TS Analyzer did not resume measuring IP In Flows correctly after restarting 

the instrument. Disabling and enabling the corresponding Network Adapter had to 

be carried out. This has been corrected. 
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● TS Analyzer: "PID List" view did not show the "Video HEVC" stream type. This 

has been corrected. 

● In rare cases, the "Null Packets (PID 8191)" node in the TS tree view was 

missing. This has been corrected. 

● For service names in the TS tree view, all asterisk characters "*" were 

suppressed. This has been corrected. 

● If the T2-MI TS contained referenced services with associated PCR-PIDs, the 

PCR Analysis (DVMS-K19) could not be started for the service elements. This has 

been corrected.  

● T2-MI Compliance Analysis (R&S DVMS-K3): If ISSY mode was on, ACM/CCM 

signaling was not correctly taken into account. This has been corrected. 

● If the T2-MI transport stream contained PAT and PMT packets and the time 

distance between these packets was large, the PMT could be interpreted wrongly 

as T2-MI packet (arbitrary cell info). In consequence, incorrect monitoring errors 

were reported. The probability of this fault increased with the time distance 

between PAT and PMT packets. This has been corrected. 

● If the SFP interface and the 1000Base-T interface (R&S DVMS B40) were both 

used: 

─ For input of multiple UDP or RTP streams and increased network jitter was 

present, TS data processing was corrupted and incorrect monitoring errors 

were reported. This has been corrected. 

─ In the same LAN, the specified data rate could not be processed 

successfully. This has been corrected. 

● Monitoring errors were identified wrongly for T2-MI due to discontinuity of the 

transport stream carried in BBFrames (R&S DVMS-K3). This has been corrected. 

● Memory leaks removed, which could occur during a complete loop over the SNMP 

RF measurement tables. 

● In rare cases, processing of PLPs was not configured correctly, which lead to sync 

loss indication of the PLP in the TS tree (R&S DVMS-K3). This has been 

corrected. 

● SNMP walk did not show all inputs if the previous input contained PLPs 

(R&S DVMS-K3). This has been corrected. 

● T2-MI TS monitoring errors were identified wrongly due to T2-MI packet errors 

(R&S DVMS-K3). This has been corrected. 

● For T2-MI streams with a PLP change, a deadlock situation could occur (R&S 

DVMS-K3). This has been corrected. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 
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1.4 Version 2.68.0 (November 2016) 

New Functionality 

● Windows 7 images: Shortcut for terminating a remote desktop session added to 

the desktop. 

● New monitoring parameter “PTS/PCR Delay” (requires R&S DVMS-K11). 

● Buffer Analysis (R&S DVMS-K24) supports HEVC content. 

● T2MI Extension (R&S DVMS-K3) includes a T2MI Compliance Analysis to verify a 

consistent and standard conform T2MI setup. 

Modified Functionality 

● Web GUI:  

─ Certificates have been added to allow access to Viewer Application with Java 

Runtime Versions >= 7.  

─ The VNC access via WEB browser has been removed. To operate the 

system via VNC an appropriate client needs to be installed on the client PC. 

Fixed Issues 

● Stability improvements for non-standard conform T2MI transport streams 

(R&S DVMS-K3). 

● R&S DVMS1: Indication of external clock status (reference input). Hint: The 

external clock status is shown as “unknown” if the RF input is not activated. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

1.5 Version 2.66.0 (April 2016) 

New Functionality 

● HEVC video content can be identified and streamed to an external PC for 

decoding. 

Modified Functionality 

● None 

Fixed Issues 

● R&S DVMS4: Possible mutual impairment of TS ASI inputs on "Sync Lock/Loss" 

events is leading to incorrect log reports for the affected inputs. The more inputs 

are used, the more likely it is. This problem has been corrected. 

● Under certain circumstances, an abnormal termination of the "dvms_kernel.exe" 

process occurred during operation of DVB-T. This has been corrected. 
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● A deadlock occurred on an SNMP walk in "controlMonitoringConfigAlarmTable" 

table if certain software options were not installed. This problem has been 

corrected. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

● For Windows 7 instruments, the VNC only shows a picture if the DVI output is 

connected to a monitor. 

1.6 Version 2.64.2 (January 2015) 

New Functionality 

● Newly produced R&S DVMS instruments (serial numbers >=103000 for DVMS1 

and >=102000 for DVMS4) come with the Windows7 32 bit operating system. On 

Windows7 the VLC and the qPSNR analysis (R&S DVMS-K21) can be applied to 

H.264 decoded video. The firmware also supports previously produced 

instruments running the operating system Windows XP. 

● "Service Provider Name", "CA mode" and "Running State" can be queried via 

SNMP. 

● Sections can be selected via SNMP. 

● The Logical Channel Number (LCN) is shown as additional information of the 

service name if it is available. 

Modified Functionality 

● None 

Fixed Issues 

● Control signs (bold on, bold off) were shown as special characters in service 

names. The service names are now shown without control signs. 

● Selection of Bouquet ID via SNMP was not possible under all circumstances. 

Bouquet IDs can now be selected independently of the selection history. 

● ASI(T2-MI) could only be selected if at least 2 monitoring options (R&S DVMS-K1) 

and the T2-MI Extension (R&S DVMS-K3) were installed. The functionality is now 

available with 1 monitoring option (R&S DVMS-K1) and the T2-MI extension (R&S 

DVMS-K3). 

● Watchdog settings were saved only after closing the application. The watchdog 

settings are now saved immediately. 

Known Issues 

● Echo pattern (R&S DVMS K58): The number of possible echoes is currently 

limited to 7 for DVB T (R&S DVMS B53 only). 
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● For Windows7 instruments the VNC only shows a picture if the DVI output is 

connected to a monitor. 

1.7 Version 2.62.2 (September 2013) 

New Functionality 

● None 

Modified Functionality 

● None 

Fixed Issues 

● Improved synchronization on high level RF signals for the DVB-T2 (RS DVMS-

B54) and DVB-T/DVB-T2 model 2 (R&S DVMS-B55) receiver modules. 

● The MER value shown with model R&S DVMS-B53 was by a factor 10 too high in 

version 2.60.0 and 2.62.0. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

1.8 Version 2.62.0 (August 2013) 

New Functionality 

● Supports the SFN network delay measurement, included in the advanced TS 

monitoring software option (R&S DVMS-K11). The measurement values are 

displayed in the "Transport Stream" view, "SFN Network Delay" pane. 

Corresponding monitoring parameter are added to the "SFN Synchronization" 

monitoring group. The external connector 1PPS REF IN is used to input the 1PPS 

reference signal derived from an external GPS receiver. 

Modified Functionality 

● None 

Fixed Issues 

● MER measurement improvements for DVB-T on the DVB-T/DVB-T2 receiver 

modules, model 3 (R&S DVMS-B55). 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 
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1.9 Version 2.60.0 (August 2013) 

New Functionality 

● Support of T2 version 1.3.1 for newly produced modules (R&S DVMS-B55, part 

number 2113.9986.02. This corresponds to order number 2113.8850.03). 

● SNMP traps can now be also configured via the GUI (see Instrument 

Configuration / System Settings dialog). 

● The watchdog does not have to be switched off before installing a new firmware 

version. The setup automatically stops the watchdog. After the firmware update 

and the reboot of the instrument, the watchdog will be enabled again if it was 

enabled before the firmware update. 

Modified Functionality 

● The device footprint shows the B option number of the modules. 

Fixed Issues 

● R&S DVMS1 only: For R&S DVMS-B40 updates, the instrument must be powered 

off and on after the update. 

… Update can now be performed without powering the instrument off. 

● IP reception (R&S DVMS-B40) was unstable for low bit rates (<500 kbits/s). 

… IP reception is now stable also at low bit rates. 

● The "Timing Offset", "SFN Echo Error" and "Shoulder ATT" statistics counter do 

not work in the WEB GUI. 

… All statistics counter work correctly in the WEB GUI. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

1.10 Version 2.58.0 (February 2013) 

New Functionality 

● The firmware can be installed remotely on several instruments simultaneously 

(see section 3.1.2.2). 

Modified Functionality 

● The individual BER monitoring parameters for DVB-T and DVB-T2 can be enabled 

separately. 

● The maximum number of services displayed in the pie chart within the "Services" 

view has been increased to 50.  
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Fixed Issues 

● None. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

● R&S DVMS1 only: For R&S DVMS-B40 updates, the instrument must be powered 

off and on after the update. 

1.11 Version 2.56.0 (January 2013) 

New Functionality 

● Supports IP module layout variant 03 (R&S DVMS-B40). 

Modified Functionality 

● EPG text data (R&S DVMS-K16) are now represented in the character set 

signaled within the EIT tables. 

Fixed Issues 

● WEB GUI does not show all statistics counters for RF monitoring. 

… the WEB GUI shows now all RF statistics counters correctly. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

● R&S DVMS1 only: For R&S DVMS-B40 updates, the instrument must be powered 

off and on after the update. 

1.12 Version 2.54.0 (November 2012) 

New Functionality 

● New OIDs have been implemented to reset the RF measurement results via 

SNMP. 

● Interpreter (R&S DVMS-K20) supports new MPEG system descriptors according 

to ISO/IEC 13818-1 (ITU-T recommendation H.222.0) from 06/2012. 

● IP Module (R&S DVMS-B40) now provides dejittering of transport streams 

received as IP flows. Dejittering is applied to transport streams for TS analysis 

and TS output interfaces. 
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Modified Functionality 

● The MER averaging, introduced in version 2.52.0, is reset after a frequency 

change. 

Fixed Issues 

● If the "Logging to File" or "TS Capture" functions (R&S DVMS-K18) were active at 

the time of a power cut, they are not restarted at the next analyzer start. 

… the functions are restarted now. 

● The function "Logging To File / Log per Day" does not work correctly for PLP 

inputs (R&S DVMS-K3). After a sync loss a new log file is created. 

.. this function works now also correctly for PLP inputs. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53 only). 

● R&S DVMS1 only: For R&S DVMS-B40 updates, the instrument must be powered 

off and on after the update. 

1.13 Version 2.52.0 (July 2012) 

New Functionality 

● New OIDs in "measurementsSigInterfacesEchoLimitTable" SNMP table to support 

a direct access to the time and level values of the echo associated to the limit 

(R&S DVMS-K58). 

● New OIDs in "measurementsSigInterfacesDvbtTable" and 

"measurementsSigInterfacesDvbt2Table" SNMP tables to indicate whether all 

echoes are within their specified limits (R&S DVMS-K58). 

● Interpreter (R&S DVMS-K20): 

─ Supports new stream types according to definitions of ISO/IEC 13818-1, 

ISO/IEC 13818-6, ISO/IEC 13818-11, ISO/IEC 14496-3, ISO/IEC 14496-10, 

ISO/IEC 14496-17, ISO/IEC 23002-2. 

─ Supports T2-MIP according to ETSI TS 102773 Annex B. 

─ Supports L1 data for DVB-T2-Lite according to ETSI EN 302755 V1.3. 

─ Provides improved elementary stream information for AAC audio.  

● Web GUI can display spectrum (R&S DVMS-K57) and Echo pattern 

(R&S DVMS-K58). 

● Video player, qPSNR analysis (R&S DVMS-K21) and buffer analysis 

(R&S DVMS-K24) additionally support transport streams with a packet length of 

204 bytes and 208 bytes. 
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Modified Functionality 

● MER value for DVB-T (R&S DVMS-B53 and R&S DVMS-B55) and DVB-T2 

(R&S DVMS-B54 and R&S DVMS-B55) is averaged over a sliding window of 

30 seconds. 

● BER values below the measurement capability are reported as "0.0E-x", where x 

is defined by the measurement capability according to the datasheet. In the 

previous version, these values were reported as "0". This applies to 

R&S DVMS-B51, R&S DVMS-B53, R&S DVMS-B54 and R&S DVMS-B55. 

● The default profile for measuring the data rate of NULL packets has been 

changed to "MGB1 (188,1s,1s)". 

Fixed Issues 

● The configuration of "Time Slicing", "MPE-FEC" and "In Depth Interleaver" was 

swapped in version 02.50.11. "On" was interpreted as "Off" and "Off" was 

interpreted as "On".  

… the configuration is now correct. 

● Improved performance for thumbnail view (R&S DVMS-K17) if the same video or 

audio PID is referenced in several services. 

● The resolution of the frequency offset for DVB-S2 and symbol rates below 

10 MSymbols/s (R&S DVMS-B51) did not reach the specified value of 1 kHz. 

… The specified resolution of 1 kHz for the frequency offset is now also reached 

for symbol rates below 10 MSymbols/s. 

● Configuration of "IP In Flows": IGMPv3 join/leave messages now include source 

filter IP address (R&S DVMS B40). 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (R&S DVMS-B53). 

● R&S DVMS1 only: For R&S DVMS-B40 updates, the instrument must be powered 

off and on after the update. 

1.14 Version 2.50.11 (April 2012) 

New Functionality 

● Support of DVB-T/T2 receiver module (R&S DVMS-B55) with DVB-T demodulator 

(R&S DVMS-K53) and DVB-T2 demodulator (R&S DVMS-K54). 

● For T2-MI monitoring (R&S DVMS-K3), a total number of 16 PLPs can now be 

monitored in parallel. 

● Echo pattern (R&S DVMS-K58): The time reference can be changed to be either 

"Strongest Echo" or "First Echo". 
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● For RF DVB-T2 signals (R&S DVMS-B54 and R&S DVMS-B55), the properties of 

the common PLP (if available) associated to the selected data PLP are shown in 

the Constellation, Echo Pattern (R&S DVMS-K58) and Spectrum View 

(R&S DVMS-K57) and are also available via SNMP. 

● For RF DVB-T2 signals (R&S DVMS-B54 and R&S DVMS-B55), the L1-pre 

signaling parameters, the data PLP parameters and the common PLP parameters 

can be monitored. The number of data PLPs can also be monitored. 

● If the applied TS data rate exceeds the specification of the device, a 

corresponding report entry is displayed in the Statistics & Log View.  

● Display of the device identification code in the "About" dialog and the "Device 

Footprint" to support the "Portable Option Key Licenses". 

● A progress bar for the echo pattern view (R&S DVMS-K58) was added. 

Modified Functionality 

● R&S DVMS4: The "Inter Module Connection" counter for the IP module 

(R&S DVMS-B40) is no longer needed and has been removed. 

● Only activated inputs can be used as sources for outputs. 

● The "FFT Mode", "Guard Interval" and "Cell ID" monitoring parameters for RF 

DVB-T2 (R&S DVMS-B54 and R&S DVMS-B55) have been moved from the 

"Signal Template" group to the "L1-pre Signaling" group. 

● The "Constellation" and "Code Rate" monitoring parameters for RF DVB-T2 

(R&S DVMS-B54 and R&S DVMS-B55) have been moved from the "Signal 

Template" group to the "Data PLP Parameters" group. 

● The monitoring parameters for the input level can now be adjusted with an 

accuracy of 0.1 dBm. In previous versions, they could be adjusted by 1 dBm. 

However, the accuracy of the input level measurement is defined in the data 

sheet. 

● The lower limit of MER for DVB-T, DVB-T2 and DVB-S/S2 can now be configured 

down to 0 dB. For the measurement capability see the data sheet. 

● The lower limit of C/N and Eb/N0 for DVB-S/S2 can now be configured down to 

0 dB. For the measurement capability see the data sheet. 

● The lower limit for the input level of DVB-S/S2 can now be configured down 

to -97 dBm. For the measurement capability see the data sheet. 

● Extension of the table interpreter (R&S DVMS-K20) concerning the DTG logical 

channel descriptor. 

Fixed Issues 

● The following T2-MI monitoring parameters are not yet available: PLP Num 

Blocks, Transmission Order, Timestamp, Frame Length, Consistency. 

… these parameters can now be monitored. 

● SNMP access for T2-MI (R&S DVMS-K3) not yet available. 
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… SNMP access for T2-MI (R&S DVMS-K3) is now available. 

● Total number of services to be shown in the EPG display is limited to 200. 

… No restriction to the number of services in the EPG display. 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

… the buffer analysis works now also correctly for H.264. 

Known Issues 

● Echo pattern (R&S DVMS-K58): The number of possible echoes is currently 

limited to 7 for DVB-T (B53). 

● For updates on R&S DVMS1 with R&S DVMS-B40 the device must be powered 

off and on after the update. 

1.15 Version 2.40.7 (November 2011) 

New Functionality 

● None 

Modified Functionality 

● None 

Fixed Issues 

● IP packets of IP outputs (R&S DVMS-B40) do not contain the source address. 

… source address is now available. 

● Unicast is not working for IP inputs in version 02.40.3 (R&S DVMS-B40). 

… Unicast is now working again. 

● BER limits could not be edited in version 02.40.3 (R&S DVMS-B51, R&S DVMS-

B53, R&S DVMS-B54)  

… BER limits can now be edited again. 

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● Total number of services to be shown in the EPG display is limited to 200. 

● Echo pattern (R&S DVMS-K58): the number of possible echoes is currently limited 

to 7 for DVB-T. 

● SNMP access for T2-MI (R&S DVMS-K3) not yet available. 

● The following T2-MI monitoring parameters are not yet available: PLP Num 

Blocks, Transmission Order, Timestamp, Frame Length, Consistency. 
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1.16 Version 2.40.3 (October 2011) 

New Functionality 

● T2-MI Monitoring (R&S DVMS-K3). 

Modified Functionality 

● None 

Fixed Issues 

● IP outputs of R&S DVMS-B40 not yet supported. 

… IP outputs now available. 

● External clock state for R&S DVMS-B40 is not yet available. 

.. External clock state for R&S DVMS-B40 is now available. 

● SFP module interface of R&S DVMS-B40 not yet supported. 

… SFP module interface of R&S DVMS-B40 is now supported. 

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● Total number of services to be shown in the EPG display is limited to 200. 

● Echo pattern (R&S DVMS-K58): the number of possible echoes is currently limited 

to 7 for DVB-T. 

● IP packets of IP outputs (R&S DVMS-B40) do not contain the source address. 

● SNMP access for T2-MI (R&S DVMS-K3) not yet available. 

● The following T2-MI monitoring parameters are not yet available: PLP Num 

Blocks, Transmission Order, Timestamp, Frame Length, Consistency. 

1.17 Version 2.30 (August 2011) 

New Functionality 

● Support of IP interface module (R&S DVMS-B40). 

Modified Functionality 

● None 

Fixed Issues 

● None 
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Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● Total number of services to be shown in the EPG display is limited to 200. 

● Echo pattern (R&S DVMS-K58): the number of possible echoes is currently limited 

to 7 for DVB-T. 

● IP outputs of R&S DVMS-B40 not yet supported. 

● External clock state for R&S DVMS-B40 is not yet available. 

● SFP module interface of R&S DVMS-B40 not yet supported. 

1.18 Version 2.20 (May 2011) 

New Functionality 

● Support of DVB-T2 receiver module (R&S DVMS-B54) 

● Device foot print 

Modified Functionality 

● None 

Fixed Issues 

● SNMP access for spectrum and shoulder attenuation (R&S DVMS-K57) and echo 

pattern (R&S DVMS-K58) not yet supported. 

... access via SNMP is now provided. 

● In rare cases, the keyboard of R&S DVMS4 does not work after a device reboot. A 

restart of the Analyzer application fixes this problem. 

… keyboard of R&S DVMS4 is now working reliably. 

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● Total number of services to be shown in the EPG display is limited to 200. 

● Echo pattern (R&S DVMS-K58): the number of possible echoes is currently limited 

to 7 for DVB-T. 
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1.19 Version 2.10 (December 2010) 

New Functionality 

● Support of ISDB-T(B) TS monitoring for transmitter supply (broadcast transport 

stream BTS). 

Modified Functionality 

● None 

Fixed Issues 

● For R&S DVMS4, "Logging to File" only available for TS inputs of base unit. 

... now working for all activated inputs in parallel. 

● Packet length of 208 is not yet supported on R&S DVMS4. 

… now also supported on R&S DVMS4. 

● Improved support of R&S Scheduler Suite. 

… visualization of inputs used by R&S Scheduler Suite corrected.  

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● SNMP access for spectrum and shoulder attenuation (R&S DVMS-K57) and echo 

pattern (R&S DVMS-K58) not yet supported. 

● Total number of services to be shown in the EPG display is limited to 200. 

● The number of possible echoes  (R&S DVMS-K58) is currently limited to 7. 

● In rare cases, the keyboard of R&S DVMS4 does not work after a device reboot. A 

restart of the Analyzer application fixes this problem. 

1.20 Version 2.00 (November 2010) 

New Functionality 

● Control of R&S DVMS4. 

● Support of DVB-S receiver module (R&S DVMS-B51). 

● Support of ISDB-T and ISDB-TB standards. 

● Spectrum and shoulder attenuation (R&S DVMS-K57). 

● Echo pattern (R&S DVMS-K58). 

● External clock status is shown in status bar. 

Modified Functionality 

● None 
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Fixed Issues 

● Buffer analysis can be started only once. 

● Long service names are not completely shown in TS tree. 

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

● SNMP access for (R&S DVMS-K57) and (R&S DVMS-K58) not yet supported. 

● For R&S DVMS4, "Logging to File" only available for TS inputs of base unit. 

● Packet length of 208 is not yet supported on R&S DVMS4. 

● Total number of services to be shown in the EPG display is limited to 200. 

1.21 Version 1.10 (July 2010) 

New Functionality 

● EPG display (R&S DVMS-K16): electronic program guide display and analysis. 

● Context sensitive help. 

Modified Functionality 

● qPSNR analysis (R&S DVMS-K21): average, peak min and peak max values are 

calculated for I-frames only. 

Fixed Issues 

● Interpreter option (R&S DVMS-K20): TDT/TOT can be interpreted. 

Known Issues 

● Buffer analysis (R&S DVMS-K24) for H.264 is not working properly. 

1.22 Version 1.00 (March 2010) 

Functionality 

● Control of R&S DVMS1 equipped with DVB-T/H receiver module (R&S DVMS-

B53) or Single TS input module (R&S DVMS-B11). 

● TS monitoring option (R&S DVMS-K1): TS input activation with TS monitoring 

according to TS 101 290. 

● Advanced TS monitoring option (R&S DVMS-K11): extended checks, hiding of 

events, event navigator. 

● Template monitoring option (R&S DVMS-K12): template monitoring for service 

structure. 

● Thumbnail display option (R&S DVMS-K17): AV thumbnail display for SD/HD. 
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● TS capture option (R&S DVMS-K18): TS capture with trigger on event. 

● PCR/PTS analysis option (R&S DVMS-K19): graphical PCR/PTS analysis. 

● Interpreter option (R&S DVMS-K20): packet/table/PES interpreter. 

● qPSNR analysis option (R&S DVMS-K21): single ended coding quality analysis. 

● Carousel and MPE analysis option (R&S DVMS-K22): data broadcast 

MPE carousel analysis. 

● DVB-H analysis option (R&S DVMS-K23): DVB-H time slice and ESG analysis. 

● Buffer analysis option (R&S DVMS-K24): AV system buffer analysis for MPEG-

2/H.264 SD/HD video, MPEG-2 audio. 

● High-quality MER measurement option (R&S DVMS-K59): extension for DVB-T/H 

interface, MER measurement up 36 dB. 

Known Issues 

None 
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2 Modifications to the Documentation 

The current documentation is up-to-date. 
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3 Firmware Update 

3.1 R&S DVMS1 Firmware Update 

3.1.1 Important Update Information 

After the update, any instrument setting could be lost. To avoid the loosing of 

instrument settings, save the "Site Configuration" before doing the update. Thus the 

data can be recalled after the update by opening the saved "Site Configuration" if 

needed. 

Saving the "Site Configuration" 

► In the R&S DVMS application, in the "File" menu, select "Save Site Configuration". 

Opening the saved "Site Configuration" 

► In the R&S DVMS application, in the "File" menu, select "Open Site 

Configuration". 

3.1.2 Updating the Firmware 

3.1.2.1 Local Installation 

Update preparations 

1. Close all applications on the R&S DVMS1 including the R&S DVMS application. 

2. Start the Windows Explorer.  

3. Copy the new R&S DVMS1 firmware file DVMS1Setup_xxx(Release).exe to any 

folder on the R&S DVMS1.  

R&S DVMS1 update 

1. Start the installation routine by double-clicking DVMS1Setup_xxx(Release).exe on 

the R&S DVMS1.  

2. Select "Local Installation". 

3. In the "Packages selection display", click "Install".  

4. After the setup routine has finished, it asks for a reboot. Confirm the reboot of the 

operating system. 

After the reboot, the Analyzer application is automatically started.  

Checking the firmware version 

► In the "Help" menu, select "About DVMS…" to check the firmware version of the 

R&S DVMS application. 
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3.1.2.2 Remote Installation 

1. Start the DVMS1Setup_xxx(Release).exe on your local computer that must be 

connected to the LAN of your R&S DVMS devices. 

2. Select "Remote Installation". 

3. Click "Next". 

 

4. Click "Options". 
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5. In the "Device Group" field, enter "DVM".  

6. Enable "Enable Port No. 17".  

 

7. Click OK.  

8. Click "Next".  
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9. The following might be necessary: 

a) In the "Device Group" field, enter "DVM" and and click "Rescan".  

A list of R&S DVMS1 devices detected in your LAN is displayed.  

b) Select the devices which you want to update.  

c) If the devices are not detected, you can obtain additional information on the 

LAN requirements by clicking "Help". 

10. Start the installation by clicking "Install".  

The firmware is installed on the selected devices. The devices will automatically 

reboot after the installation is complete. 
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3.2 R&S DVMS4 Firmware Update 

3.2.1 Important Update Information 

After the update, any instrument setting could be lost. To avoid the loosing of 

instrument settings, save the "Site Configuration" before doing the update. Thus the 

data can be recalled after the update by opening the saved "Site Configuration" if 

needed. 

Saving the "Site Configuration" 

► In the R&S DVMS application, in the "File" menu, select "Save Site Configuration". 

Opening the saved "Site Configuration" 

► In the R&S DVMS application, in the "File" menu, select "Open Site 

Configuration". 

3.2.2 Updating the Firmware 

3.2.2.1 Local Installation 

Update preparations 

1. Close all applications on the R&S DVMS4 including the R&S DVMS application. 

2. Start the Windows Explorer.  

3. Copy the new R&S DVMS4 firmware file DVMS4Setup_xxx(Release).exe to any 

folder on the R&S DVMS4.  

R&S DVMS4 update 

1. Start the installation routine by double-clicking DVMS4Setup_xxx(Release).exe on 

the R&S DVMS4.  

2. Select "Local Installation". 

3. In the "Packages selection display", click "Install".  

4. After the setup routine has finished, it asks for a reboot. Confirm the reboot of the 

operating system. 

After the reboot, the Analyzer application is automatically started.  

Checking the firmware version 

► In the "Help" menu, select "About DVMS…" to check the firmware version of the 

R&S DVMS application. 
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3.2.2.2 Remote Installation 

The remote installation can be performed in the same way as for the R&S DVMS1. It is 

initiated by executing DVMS4Setup_xxx(Release).exe on your local computer which 

must be connected to the LAN of your DVMS devices. 

3.3 Installing and Uninstalling Software Options 

See User Manual, chapter "Options and Versions". 
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4 Customer Support 

Technical support – where and when you need it 

For quick, expert help with any Rohde & Schwarz equipment, contact one of our 

Customer Support Centers. A team of highly qualified engineers provides telephone 

support and will work with you to find a solution to your query on any aspect of the 

operation, programming or applications of Rohde & Schwarz equipment. 

Up-to-date information and upgrades 

To keep your instrument up-to-date and to be informed about new application notes 

related to your instrument, please send an e-mail to the Customer Support Center 

stating your instrument and your wish. We will take care that you will get the right 

information. 

Europe, Africa, Middle East 
Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com 

North America 
Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com 

Latin America 
Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com 

Asia/Pacific 
Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com 

China 
Phone +86-800-810-8828 / +86-400-650-5896 
customersupport.china@rohde-schwarz.com 
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